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Important information about IA 2.0

This document contains information about the most frequently asked questions and problems 
using IA 2.0.  Below this are described the changes between the 1.00 release of Instant Artist 
and the 2.0 release of IA for Windows.  It also includes changes implemented in the 1.01 
release of Instant Artist.

1. Bad Disks:  If you get any type of disk error when installing IA 2.0, it is probably due to bad 
disks.  You can get replacement disks by calling IAUC at 1-800-743-1792.
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2. Install Error: Out Of Environment Space: If you got this message when installing a previous 
version if IA 2.0, you could have fixed it in the following way, depending on which version of 
DOS you have:

DOS 6 Reboot the system.  When Dos presents the message "Starting MS-DOS" or  
"Starting IBM DOS" hit the F5 key.  The message "DOS will bypass your config.sys
and autoexec.bat" will appear and the user will be at a C: prompt.  Simply switch
to the A: or B: prompt and run SETUP from DOS.
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DOS 5 or lower          First try exiting Windows completely and running the SETUP form DOS.

If this does not work, rename the autoexec.bat file to something else. (like
autoexec.old) and re-boot the system.  Then run SETUP from A: or B: and when it
is done, restore the autoexec to its original name.

3. Install Error: "This directory does not exist or is not an IA directory."  Make sure that you are 
not trying to install a Windows upgrade to a DOS version, or vice versa.  If you received the 
wrong version, call IAUC for a replacement.

4. If there is a problem finding the DATA directory during the installation, the graphics files may 
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be corrupt in the original version.  Simply re-install version 1 of Instant Artist and then install 
the upgrade.

5.  If you cannot import TIFF images correctly (i.e. blue backgrounds appear, etc.) this is 
because different TIFF software deals with TIFFs in different ways.  Also, IA cannot handle 24-
bit TIFF images.  You may have better luck if you can convert your TIFF image to BMP or PCX 
format. 

If you have a TIFF image that does not load correctly (other than 24-bit TIFF images), please 
send it to us.  We may then be able to figure out how to accommodate images like it in a future
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version.  You can send it to Vince at Pixellite through America On Line, address VMILLS. 

6. On 16-color displays, a bit-map image will come up as a 16-color posterized image, but will 
print in 256 colors.  This is done instead of dithering to speed up the program.

7. General Protection Fault in module PIXTYPE.DLL or PIXRES.DLL.  This is a bug in the 
program when it tries to load very complex WMF's (Windows Meta-Files).  It is currently being 
worked on.  Be careful!  When this happens, IA is left in memory, so if it crashes a number of 
times, you may wind up running out of memory.  If this happens, exit Windows and restart it.



Windows, Page 6
8.  Printing seems to take forever?  Try disabling "Print Manager" from the Printer Control 
Panel.

9.  Canon BJC 600 printer:  When printing envelopes with this printer, you must check "Rotate 
Never" (in the Print Configure dialog box),  Choose "8.5 x 11" paper size (in the Print Setup 
dialog box), and feed the envelope in sideways to print properly.  If you feed the envelope in 
normally, it will have an unprintable area on the right hand side.

10. HP DeskJet 500, 550C:  On these printers there is a 1\2" unprintable space at the bottom 
of each page.  This is a physical limitation of the printer.
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11. How to do printer alignment:  Go to the File menu, select Print, then select Print Area.  You 
will now be in the Setup Printable Area screen.  On tractor feed printers, there will be just one 
line printed.  This line should match up with the paper perforations.  On page printers, a 
crosshair will be printed.  Follow the instructions on the printed page and enter the 
measurements into the Select Printable Area parameters.  For more information see section 
8B below.

12.  If the printable area seems consistently small, check the default paper source on the 
printer.  It may be set to something other than 8.5 x 11.
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13.  If cut-and-fold envelopes take two pages, "Rotate Never" (in the Print Configure dialog 
box) must be set.

IA 2.0 for Windows
Changes
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1. Set Directories dialog and Imported Graphics

Paths for the following graphics formats have been added to the SET DIRECTORIES dialog:

BMP (*.BMP)
EPS (*.EPS)
GIFF (*.GIF)
PCX (*.PCX)
TIFF (*.TIF)
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New Print Shop®
Print Shop Deluxe®
Third Party IA Graphics (*.GFX)

To make New Print Shop or Print Shop Deluxe graphics available in IA, go to SET 
DIRECTORIES in the File menu.  The pathnames to set the directories to are as follows 
(assuming they were installed with the default pathnames):

New Print Shop \NEWPS
Print Shop Deluxe (DOS) \PSDELUXE\GRAPHICS
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Print Shop Deluxe (Windows) \PSDWIN\GRAPHICS

Limits on imported graphics:

EPS - IA can't read 1) text made with PostScript or Truetype fonts, 2) graduated fills,  3) 
clipping to a path (masks), or 4) embedded  bitmaps.  Most EPS files created in Adobe 
Illustrator, Corel Draw, or by the Hewlett-Packard LaserJet Windows print driver, can be read 
by IA.  If there is something in the EPS file that IA cannot interpret, then a warning message 
will be displayed.  If you choose to continue, IA will skip over the offending portions and 
attempt to read the remainder of the graphic.  In which case, some parts of the graphic may be
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missing.  In some cases, when IA cannot figure out enough of the graphic, the entire graphic 
will be skipped and will not appear in the graphics list.  There a limit of 800 vectors per polygon
(will partially convert)

TIFF - IA can't handle compressed files with internal records larger than 64K bytes.  File 
compressed in LZW and PACKBITS formats are read.  However, CCITT compressed files are 
not read.  IA will read files in  2,16, and 256 colors.

Print Shop Deluxe - IA does not read the following Print Shop Deluxe graphic types: banner 
backdrops, line graphics, borders and tiled graphics.  Also very complex graphics such as the 
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Birthday Cow might not be read.

Third Party IA graphics - These graphics generally do not have multiple preset colors or a 
specially designed monochrome version, as do original IA graphics.

PCX:  IA will handle 2, 4, 8 ,16, and 256 colors.   24 bit (16 meg) color files are not read.

GIF:  IA will handle 2 color or 256 color.  It will also read the GIF interleave format.  24 bit (16 
meg) color files are not read.
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BMP:  IA will handle 2 , 16, and 256 colors.  24 bit (16 meg) color files are not read.

If IA cannot read a graphic, it is skipped and does not appear on the graphics list.

IA has a capacity of approximately 3,800 graphics and fonts.  The exact amount depends upon
many factors and is hard to predict exactly.  Generally speaking, the program will run slower 
the more graphics and fonts you have loaded.  Therefore, it is usually better not to have more 
loaded than necessary.  If you exceed the allowable amount, a warning message is displayed 
suggesting that you reduce graphics or fonts by a certain number.
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All bitmap graphics are rectangular.  Only vector-based graphics (IA, Print Shop Deluxe®, 
EPS) have shapes other than rectangular.  Also the entire frame of a bitmap graphic is "filled" 
with color (white becomes transparent).  However, with vector-based graphics, only the areas 
of the graphic itself are colored.

Bitmap graphics cannot be skewed (no skew handle will appear on the frames), and can be 
rotated only in 90-degree increments.  They can be resized in the same way as IA graphics.

Shape commands have no effect on bitmapped graphics.
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All colors in imported graphics are converted to the IA color palette.  This may not always 
result in a true depiction.  Further, 256 gray scale images are converted to a 16 color gray 
scale, thus losing much detail.

3.  Import

The allowable import formats has been increased from just metafiles to also include TIFF, GIF, 
PCX, EPS, and BMPs.
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4.  Text Entry dialog

The Text Entry dialog has been re-arranged to put the special characters in the lower portion of
the dialog.

5.  Monochrome Mode

Selecting MONOCHROME MODE from the VIEW menu will now cause the working document 
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to be converted to monochrome.  This operation cannot be undone.  Converted documents 
may not look good as different colors may result in the same gray scale value.  For best 
results, you should be in monochrome mode before selecting a layout or graphic.  In that way, 
IA will load the special monochrome version.

6.  Change Dimensions

The "CHANGE BANNER LENGTH" on the OBJECT menu has been replaced with "CHANGE 
DIMENSION" and  is now available for all document types.  This feature  makes it possible to 
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define any document size. Also, many predesigned forms such as labels and business cards 
can be accommodated.

CHANGE DIMENSIONS dialog description:

WIDTH and HEIGHT: Valid range is from .5" to 127"

RESIZE OBJECTS: Objects are moved and resized for best fit on new document 
size
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7.  Select Graphics dialog

IA: Click this to see the list of native IA graphics as well 
as converted metafile and EPS graphics that were copied from 
the clipboard.

NEW PRINT SHOP: Click this to see the list of New Print Shop graphics which can 
be read by IA.
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PRINT SHOP DELUXE: Click this to see the list of Print Shop Deluxe graphics which can
be read by IA.

OTHER: Click this to see the list of imported graphics.  Imported graphics
are any graphics not in IA format (e.g. PCX, GIFF, TIFF, EPS).  
The graphics appearing in these lists are those that IA found in 
the directories set in the SET DIRECTORIES dialog.

MONOCHROME: This option does different things depending upon the type of 
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graphic being selected.

IA graphics: The special monochrome version
of the graphics will be used.  These versions of each graphics 
are especially balanced for black and white display and printing 
and should be used for the best results when printing to a black 
and white printer.

Imported graphics:  The color version of the graphic will be 
converted to monochrome based upon the light value of each 
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color.  This sometimes results in different colors blending 
together.

8.  The Print dialog

Two new buttons have been added to the PRINT dialog: PRINT AREA and PRINT CONFIG.  
The dialogs invoked by these buttons operate as follows:

A.  Print Area dialog
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If your printout is not correctly centered on the page or it is going onto two pages when the 
print preview shows it on one page, then you need to set your printable area values.  The 
print drivers that come with Windows or your printer, often do not contain correct 
information about the size and location of the printable area on the page.  Without correct 
information, IA cannot correctly size and position (usually center) your output on the page.  
By accomplishing this test and then entering the settings from that test,  IA can make the 
necessary corrections.  
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B.  Printable Area Test

In order to determine your settings, you must first print out a test page.  This is done from 
the PRINT dialog, by selecting PRINTABLE AREA TEST from the list in the upper left hand 
portion of the dialog, and then printing (ENTER).  The test will print a vertical and a 
horizontal line.  The ends of these lines define the limits of the printable area.  Ignore a 
second page if one is printed.  All measurements should be taken on the first page only.  

Measure the distance from the edge of the page to the end of the nearest line and enter 
those values in the appropriate (top, bottom, right, or left) page offsets.  The values should 
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be entered in hundredths of inches.  The following table is to assist in converting from inch 
fractions to decimals:

Fraction Decimal
1/16" .06
2/16" or 1/8" .13
3/16" .19
4/16" or 1/4" .25
6" .31
6/16" or 3/8" .38
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7/16" .44
8/16" or 1/2" .5
9/16" .56
10/16" or 5/8" .63
11/16" .69
12/16" or 3/4" .75
13/16" .81
14/16" or 7/8" .88
15/16" .94
1" 1.00
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If after setting the printable area values and checking the Use 
Printable Area Values box, you find that part of your printout is 
being clipped (i.e. not printing) along either the bottom or right 
edge, then make the appropriate printable area setting a little 
larger.  If a second page is being printed, make your bottom 
offset value a little larger.

B.  The Print Config Dialog
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MISCELLANEOUS:
The following options have been added:

Thin Outlines: This feature is primarily for plotters and vinyl cutters.  Normally, 
when drawing a line or outline, IA will draw a line whose 
thickness is proportional to the rest of the graphic or object.  
However, this means that on devices such as plotters, a line is 
drawn repeatedly offset a little each time.  This option, insures 
that lines are drawn only once regardless of the their thickness.
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Show Crop Marks: You can now choose to print or not print crop marks for any 

document type, instead of just business cards and postcards.  
The default is for crop marks not to print except for business 
cards and postcards.

ROTATE:
This setting determines whether or not the document is rotated on the page.

Never: Never rotates the document.
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Automatic: IA will try to keep the document at 100% on the fewest number 
of pages.  It will rotate the document, if by doing so additional 
pages are not required.  An exception to this rule are envelopes.
In this case IA will orient the envelope according to how the 
printer normally prints envelopes.  A special case is the HP 
DeskJet 500, which feeds envelopes horizontally (i.e. rotated), 
however cannot print more than 8" horizontally.  Since US. 
Business envelopes are greater than 8" wide, IA will 
automatically shrink the document to fit in an 8" space.
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Always: Always rotates the document.

The rotation setting is saved with a document.

MARGINS:
The margin setting determines how a document is laid out on the page.
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Minimal Margins: This option is used to print as large an image on a page as 

possible.  All printing is done to the limits set in the Printable 
Area offset boxes.

All Margins Equal: This option sets all 4 margins to the largest of the 4 values in 
the offset boxes.  This option has the smallest available printing 
area.

Symmetrical Margins: This option sets the horizontal margins to the same value and 
the vertical margins to the same value.  Values used are the 
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larger of the two.  This is the optimal setting for greeting cards.

9.  Lock and Unlock Removed

The LOCK and UNLOCK commands have been removed.  Any objects that were locked and 
saved with previous versions, will be automatically unlocked when opened.

10.  Copy from the clipboard
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When you copy a metafile graphic from the clipboard, the graphic is converted to IA format and
then placed in the WMF.GFX file instead of the USER.GFX file.   Existing USER.GFX files will 
continue to be read, the program will no longer create or add to them.  If the clipboard graphic 
is in EPS format, then it is converted and placed in the EPS.GFX file.  Bitmap graphics on the 
clipboard cannot be copied and are discarded.

11.  Page Turners (new in 1.01)
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Greeting cards and postcards now have page turners to make it easier to move from one page
to another.  With a mouse, click on the lower right hand corner tab to turn to the next page.  
Clicking on the lower left hand corner tab to turn to the previous page.  If you click the gray 
shaded area below or to the side of your current page, you will turn to either the underlying or 
facing page.

12.  Grouping

IA 2.0 has new Grouping commands (GROUP and UNGROUP) in the Object menu.  
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GROUP is only active when more than one object is selected.  UNGROUP is only active
when a grouped object is selected.  A grouped object can also be grouped with other 
objects.  If all the objects in a group are of the same type, either text or graphics, then 
the appropriate menus (e.g. fonts) are available.  However, if a group contains mixed 
types, then the Effects and Fonts menus are not available.

13.  Fonts

Several improvements have been made in IA 2.0 so that it handles more Type 1 fonts.  
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However there are still instances where fonts in this format will not work:

1. The font file (.PBM) must be no larger than 64K.  Otherwise it will not be listed within
IA.

2. There are a few fonts that are internally misordered.  This is a deviation from the 
Type 1 standards, however it does not effect normal ATM typesetting nor use in IA so
long as only the Plain effect (i.e. no effect) is used.  However, the use of any other 
effect can result in letters which are misdrawn.
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14.  Advanced  Menus

The VIEW menu now has an ADVANCED MENUS option.   When checked (the default), the 
more advanced functions appear on the menus.

15.  Complement

The COMPLEMENT command has been removed from the EDIT menu.
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16.  Double Arc-Text Command

This new command in the OBJECT menu, automatically generates complementary clockwise 
and counter-clockwise arc text objects.

17.  Zoom Selected Object Keyboard Command
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The ZOOM SELECTION keyboard command has been changed to 
Control-U

18.  Quotes File

The quotes, accessed from the Text Entry dialog, now are categorized.  Consequently, the 
Insert Quote dialog has a category list as well as an author list.
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NOTICES:  

1.  Instant Artist is a Trademark of Autodesk, Inc.  While IA 2.0 is derived from Instant Artist, 
Autodesk, Inc. bears no responsibility for IA 2.0.

2.  New Print Shop® and Print Shop Deluxe® are registered trademarks of Broderbund 
Software.

3.  All other brands or product names are registered trademarks, trademarks, or service marks 
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of their respective holders.


